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Chapter 1: What is Scheduler?

Scheduler coordinates the execution of automated processes, called tasks, on a set date and time, 
or at recurring intervals. Scheduler supports tasks that run once and tasks that run repeatedly. 
Through Scheduler, Impromptu users can submit Impromptu report requests to be executed 
locally.

Scheduler can run tasks completely unattended, because you can specify security parameters for 
your databases and Impromptu catalogs when submitting tasks. Scheduler stores passwords in an 
encrypted format so that they cannot be seen when the tasks are running.

You can schedule
• Impromptu to run a specific report
• PowerPlay Transformer to create or refresh a PowerCube
• PowerPlay to update the contents of a report
• a CognosScript macro
• an executable file or DOS batch file

For example, you can create tasks that execute
• a CognosScript macro that automatically runs a production report or builds a HotFile every 

night of the week, starting at 2:00 A.M
• PowerPlay Transformer, to refresh a PowerCube at midnight every Friday
• an Excel macro, once a week on a specified day at a specified time. Your Excel macro might 

include OLE automation statements that automatically run a linked Impromptu report
• a CognosScript macro, that automatically creates a set of PowerPlay reports once a month 

and then mails the results to a group of users

Related Topics
• "Schedule and Run Tasks" (p. 11)

Run an Unattended Task
Most of the time, you will want to run Scheduler unattended so that you do not have to monitor 
the progress of the tasks you have scheduled.

Keep the following points in mind:
• Scheduler must be running to start tasks on your computer. You can minimize the Scheduler 

application window, or run Scheduler in the Windows taskbar tray, if you want to keep your 
desktop neat. If you rely on Scheduler to regularly launch tasks on your computer, you may 
want to add Scheduler to your Windows StartUp group.

• When you schedule an Impromptu report, Impromptu will request values for any prompts, 
and automatically provide these values along with any security information to Scheduler in 
order to run the report.

• If you use a CognosScript macro to run an Impromptu report that prompts for values, ensure 
that the macro provides appropriate values for the prompts. Otherwise, the report will 
prompt for input when the task runs, and the task will not complete when it is run 
unattended. You can use the PromptValue parameter of the OpenReport method to provide a 
complete list of run-time prompts for the report. 
Note: Impromptu automatically provides Scheduler with all prompts when a report is 
scheduled directly from within Impromptu.
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• If you schedule multiple reports to run back-to-back without closing Impromptu, it is 
important to note that the reports use the same catalog. To have a report use a different 
catalog, you must create and run a macro script that closes the original catalog. Alternatively, 
you can run the reports using different instances of Impromptu.

• When a task requires security parameters, such as a catalog password or a database password, 
you can specify the security values. For example, if you are running a task that accesses a 
remote Sybase database for which Impromptu and Sybase passwords are required, you can 
provide the user IDs and passwords within the task. For PowerPlay, if you are running in 
Reporter mode against a host PowerCube for which security parameters are required, you can 
provide the necessary values.
Note: Impromptu automatically provides Scheduler with the necessary security information 
when a report is scheduled directly from within Impromptu, or when Impromptu is already 
running and the user is logged into the catalog for the report being scheduled.

• Impromptu automatically tracks tasks that have run and tasks that are waiting to run. Most 
task settings are shown in the Scheduled tab (Scheduler application window). To view all 
details for a task, from the Edit menu, select the task and click Edit Task or Show Task. For 
more information, see "Edit or Reschedule a Task" (p. 15) and "View Settings for a Running 
or Completed Task" (p. 15).

• Scheduler maintains a log of task execution errors, schederr.log, stored in the folder where 
Windows puts temporary files on your computer. For more information, see "Troubleshoot 
Impromptu Errors" (p. 41). or "Troubleshoot Task Errors" (p. 41).

Related Topics
• "Processing Considerations for Local Tasks" (p. 6)

Run Multiple Renditions of Scheduler
You can run multiple renditions of Scheduler simultaneously on your computer, but only one 
rendition of Scheduler can exist with one rendition of Impromptu.

For example, you can install Scheduler to simultaneously support earlier supported versions of 
Impromptu clients. When you install Scheduler, it upgrades and preserves previous versions of 
scheduled tasks that are stored in the Scheduler database. 

Only one Scheduler dialog box appears, despite the number of versions of Impromptu 
simultaneously used to invoke Scheduler. You can use Scheduler to print an Impromptu report 
that was created in an earlier supported version of Impromptu or run an CognosScript macro file 
(.mac).

Related Topics
• "Cern.ini file" (p. 43)
• "What is Scheduler?" (p. 5)

Processing Considerations for Local Tasks
A primary advantage of Scheduler is that you can schedule long, processing-intensive tasks to run 
on your computer when you will not otherwise need it, such as late at night. You must leave the 
computer switched on with Scheduler running.

You can choose to display a warning message if you exit Scheduler before it has processed all 
scheduled local tasks.

Delays
On your local computer, only one report or CognosScript macro can be run by an application at 
one time. A scheduled task that uses a particular application will not run until a running task that 
uses the same application has finished. If a report or macro contains errors, the application that is 
generating the report or running the macro could conceivably stop running the task to await user 
intervention. Any tasks scheduled to run later will not run until the existing problem has been 
dealt with.
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Whenever possible, you should avoid having any program open a dialog that waits for input. In 
such a case, the program will pause and wait for input, possibly for many hours. Until the 
program resumes processing, all further local processing in Scheduler will wait.

Substantial delays can also occur if you schedule tools to download large amounts of information 
from bulletin boards or World Wide Web sites, or run disk checks or compression utilities. These 
tasks may slow other processing that occurs at the same time.

A delay can also occur as a result of other processing. Retries at starting tasks that initially fail to 
start are not unlimited. Scheduler will try to run the task until it is successful, or until the 
maximum delay for task execution has passed, as set in the Start tab (Options dialog box).

Related Topics
• "Get Started" (p. 9)
• "Schedule and Run Tasks" (p. 11)
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Chapter 2: Get Started

Scheduler enables you to schedule new tasks, as well as manage those you've already scheduled.

Scheduling Tasks
Use Scheduler to schedule automated processes, called tasks, at set intervals, regardless of whether 
you are at your computer. You can schedule tasks to run once only, or repeatedly. You can set 
default values for new tasks, or use an existing task as a template when creating a new task. You 
can also set a maximum allowable task delay if the time at which the task runs is critical.

How Do I Manage Tasks With Scheduler?
Once you have scheduled a task, it appears on the task list in the Scheduled tab (Scheduler 
application window). You can change any of the settings for a task before it is run. You can 
temporarily postpone the execution of a scheduled task, or when it is no longer required, you can 
permanently remove it from the task list.

After a task has been run, it appears on the task list in the Completed tab (Scheduler application 
window). From this list, you can double-click a task, to view the results in Impromptu. If you 
attempt to view a task that did not run to completion, the Errors dialog box, is shown, indicating 
the specific error that occurred. You can configure Scheduler to automatically remove completed 
local tasks from the task list after a specified number of days.

You can edit the settings for a scheduled task before it runs, or view the settings of any task. You 
can easily create new tasks that use the settings of existing tasks.

The task lists on the Completed tab and Scheduled tab can be customized. You can sort a list by 
the values in any column, or change the order and width of the columns.

You can also configure Scheduler to display warnings before it completes certain operations, and 
have it notify you of completed tasks.

Related Topics
• "Edit or Reschedule a Task" (p. 15)
• "Put a Task On and Off Hold" (p. 16)
• "Schedule and Run Tasks" (p. 11)
• "Set Security for a Scheduled Task" (p. 13)
• "View Settings for a Running or Completed Task" (p. 15)

Start Scheduler

Description
You can start Scheduler as an independent application, or you can start it from other applications, 
including Impromptu and Transformer.

If Scheduler is configured to run in the taskbar tray, the Scheduler application window will not 
open when you start Scheduler. To open the Scheduler application window, double-click the 
Scheduler icon in the taskbar tray. For more information, see "Run Scheduler in the Taskbar 
Tray" (p. 27).

Steps to Start Scheduler from Windows
• From the Start menu, click Scheduler.
• In Explorer, double-click the file schdl_go.exe.
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Steps to Start Scheduler from Impromptu
• From the Report menu, click Schedule.
• From the Tools menu, click Scheduler.
• Select Open Scheduler on the Open dialog box.
• Click the Launch Scheduler button on the PowerBar

Launch Scheduler button 

Steps to Start Scheduler from Transformer
• From the Tools menu, click Scheduler.
• Click the Scheduler button on the PowerBar.

Scheduler button 
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Chapter 3: Schedule and Run Tasks

Use Scheduler to run automated processes, called tasks, at set intervals, regardless of whether you 
are at your computer. You can schedule tasks to run locally on your computer.

You can schedule tasks to run once only, or repeatedly
• every hour
• every few hours
• every day (including weekends)
• every few days
• on selected days of the week
• every few weeks on selected days of the week
• one day each month (for example, the first or the fifteenth day of each month)
• one day from a particular set of days in each month (for example, the first Friday of each 

month)
• every few months on one day each month, or one day from a particular set of days in each 

month

Note: You can schedule tasks to be run on any date up to five years from the current date.

You can set default values for new tasks, or use an existing task as a template to create a new task. 
You can also set a maximum allowable task delay if the time at which the task runs is critical.

Single Tasks
You will often want to schedule tasks to run once only. For example:
• you use Impromptu to access a large database, extracting data for conversion to Microsoft 

Excel. You schedule the task to run the required report and perform the conversion in the 
middle of the night, when network traffic is light; 

• you plan to run PowerPlay against a large host PowerCube. You, therefore, schedule it to run 
at a time when you know that server load will be low.

Recurring Tasks
You likely use many reports that must be run repeatedly at the same time every week or every 
month. You can schedule recurring tasks to automatically prepare these reports. For example, you 
can use a recurring task to run Impromptu, producing weekly or monthly summary sales reports 
that provide up-to-date sales information; you can use a recurring task to run Transformer in 
batch to periodically refresh existing PowerCubes.

Unattended Operation
Scheduler can run tasks while completely unattended because you can specify security parameters 
for your databases and catalogs within Impromptu or Scheduler. With user IDs and passwords in 
place, you can leave Scheduler running unattended and cease worrying about unauthorized access 
to a secured database. When Scheduler runs the task, the task obtains security information from 
Scheduler as required. Scheduler stores catalog user IDs, database user IDs, and passwords in an 
encrypted form so that they cannot be seen when the tasks are running.

Scheduler can run tasks on your computer. To run a task on your computer, all you have to do is 
leave your computer switched on with Scheduler running. At the specified time, Scheduler will 
automatically run the scheduled task.

Executing Local Tasks
To run a task on your computer, simply create the task, then leave your computer switched on 
with Scheduler running. At the specified time, Scheduler automatically runs the task.
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Related Topics
• "Refine Your Tasks" (p. 15)

Schedule a Task

Description
You can use Scheduler to schedule certain tasks to run once only.

For example, you might use Impromptu to access a large database, extracting data for conversion 
to Microsoft Excel. You schedule the task to run the required report and perform the conversion 
in the middle of the night, when network traffic is light. Or, you plan to run PowerPlay Reporter 
against a large host PowerCube. You, therefore, schedule it to run at a time when you know the 
server load will be low.

You can also use Scheduler to run reports that are produced every hour, day, week, or month.

For example, you might run Impromptu summary sales reports weekly or monthly to provide 
up-to-date sales information. Or, you might run Transformer regularly in batch to refresh existing 
PowerCubes.

You can change the default time and location for running new tasks. For more information, see 
"Set Task Defaults" (p. 25).

Steps
1. Open the Scheduler application window.
2. From the Insert menu, click 

• task to schedule a task to run once only. 
• recurring task to schedule a task to run on a recurring basis.
The Identification tab (Insert Task dialog box) appears.

3. In the File Name box, type the file name and path of the new task, or click Browse to select a 
task from the File Name dialog box. You can schedule:
• an Impromptu report (.imr file)
• a PowerPlay report (.ppr file)
• a macro (.mac or .mcx files)
• executable programs (.exe, .com, .pif, or .bat files) such as Transformer
Note: If you are scheduling a remote task with shared results, use Universal Naming 
Conventions (UNC) or common file locations to avoid errors when the recipient opens the 
results you send.

4. Type a description of the task in the Description box.
The description is useful, particularly if you schedule the same task more than once, with 
different criteria.

5. From the Insert Task dialog box, click the Timetable tab.
6. Set the time at which the task is to run in the Time box.

Note: Times are expressed in 24-hour format.
7. For tasks being scheduled to run once only, set the date on which the task is to run in the On 

box. Skip to step 12.
Tip: When scheduling a task overnight, remember that the date changes at midnight.

8. For recurring tasks only, select the frequency with which the task is to run.

Select ... To ...

Hourly Run the task recurring at intervals measured in hours.

Daily Run the task at a selected time recurring at intervals measured in days. 

Weekly Run the task at the specified time on selected days of the week recurring at 
intervals measured in weeks.
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Tip: When scheduling a task overnight, remember that the date changes at midnight.

9. For recurring tasks only, in the Effective From box, set the first date that the recurring task 
will be run.
By default, the task will run at its scheduled time(s), on or after the effective date, for an 
indefinite period.
Tip: The Next Run At box shows the next date and time that the task will run, based on the 
current settings in the dialog box.

10. For recurring tasks only, if you want Scheduler to stop running the task at its scheduled 
time(s) after a certain date, select To, and type an end date for the task.

11. If you need to provide user classes, user IDs, and passwords to run the task unattended, see 
"Set Security for a Scheduled Task" (p. 13).

12. Click OK.
The Scheduled Tab appears, and the new task appears on the task list.

Related Topics
• "Edit or Reschedule a Task" (p. 15)
• "Put a Task On and Off Hold" (p. 16)
• "Schedule and Run Tasks" (p. 11)
• "View Settings for a Running or Completed Task" (p. 15)

Set Security for a Scheduled Task

Description
If you are using Scheduler to automate tasks that run against catalogs or databases with security 
requirements, you can provide the user IDs and passwords as part of the task. By providing this 
information in the task rather than in the CognosScript macro that runs the task, you avoid the 
risk of placing security information within a macro. Furthermore, changing the user IDs and 
passwords is easier.

You do not have to provide user IDs or passwords in Scheduler for Impromptu reports. 
Impromptu automatically provides this information to Scheduler.

Scheduler stores passwords in an encrypted form that prevents users from seeing them.

Monthly Run the task at the specified time on the specified date or day of the month 
recurring at intervals measured in months.

If you chose Then select

Daily The number of days between runs.

Weekly The number of weeks between runs, and the day or days of the week on 
which the task is to run.

Monthly The number of months between runs, and the day of the month on which 
the task is to run.
• Select the first option button (relative day) to run the task on a 

particular occurrence of a day. Then select the occurrence (First, 
Second, Last, etc.) and the day (Monday, Saturday, etc.). For example, 
"Second" and "Friday" cause the task to run on the second Friday of 
every month.

• Select the second option button (ordinal day) to run the task on a 
particular date. Then select the day of the month (1st, 2nd, etc.).

Select ... To ...
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Note: If you create a task that requires entry of a user ID and password to gain access to the 
catalog or database, and click the Security tab of the Edit Task dialog box, you may observe that 
the password field of the resulting prompt is blank. Asterisks indicating that the password has 
already been supplied will not appear. You may, if you wish, confirm the password by re-entering 
it, or change it following an update.

Steps
1. From the Insert Task dialog box, click the Security tab.
2. In the User Class box, type a user class for the task.

Note: The user class is used by Impromptu and is included for compatibility with macros 
created in previous versions. For PowerPlay and Transformer, the user class is defined in 
Access Manager.

3. Type the password for the user class in the User Password box.
4. If the database supports multiple user IDs, type the database user ID for the task in the User 

ID box.
5. If the database supports multiple user IDs, type the password associated with the given user 

ID in the User Password box.
6. Set all other task options.
7. Click OK.

Related Topics
• "Schedule a Task" (p. 12)
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You can change any of the settings for a scheduled task before it runs.

You cannot edit a running or completed task. However, you can view the current settings for such 
tasks.

You can temporarily postpone the execution of a locally scheduled task. For example, if access to 
a database will not be available when a recurring task is scheduled to run, you can put the task on 
hold so that Scheduler will not attempt to run it. When the database is again available, you can 
take the task off hold. The task again runs at the scheduled time(s).

When a scheduled task is no longer required, you can permanently remove it from the task list.

Related Topics
• "Get Started" (p. 9)
• "Schedule a Task" (p. 12)
• "Schedule and Run Tasks" (p. 11)

View Settings for a Running or Completed Task

Description
In Scheduler, you cannot edit a running or completed task with the Edit Task command (Edit 
menu). However, you can view the current settings for such tasks by using the Show Task 
command (Edit menu).

Steps
1. In the Scheduler window, click the tab that corresponds to the list where the desired task can 

be found.
2. Click the desired task.
3. From the Edit menu, click Show Task. 

Note: You cannot make any changes to the settings for the task.
4. Review the current settings for the task on the Show Task dialog box.
5. Click Cancel.

Related Topics
• "Edit or Reschedule a Task" (p. 15)
• "Put a Task On and Off Hold" (p. 16)
• "Refine Your Tasks" (p. 15)
• "Set Security for a Scheduled Task" (p. 13)
• "Set Task Defaults" (p. 25)

Edit or Reschedule a Task

Description
You can edit task settings any time before a task runs. To reschedule a task, edit the date and time 
settings.
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Notes
• If a local task’s scheduled execution time arrives when you are editing that task, then 

execution does not occur until you finish editing the task.
• You cannot edit a task that is already running. To display the settings of a task that is running, 

see "View Settings for a Running or Completed Task" (p. 15).

Steps
1. From the Scheduler application window, click the Scheduled tab to show the list of scheduled 

tasks.
2. Click the desired task.
3. From the Edit menu, click Edit Task. 

The Identification tab (Edit Task dialog box) appears.
4. Make the desired changes to the task.
5. Click OK.

Related Topics
• "Put a Task On and Off Hold" (p. 16)
• "Schedule a Task" (p. 12)
• "Set Security for a Scheduled Task" (p. 13)
• "Set Task Defaults" (p. 25)

Put a Task On and Off Hold

Description
You can temporarily prevent a scheduled task from running by putting it on hold. For example, if 
your computer will not be available when a recurring task is scheduled to run, you can put the 
task on hold so that Scheduler will not attempt to run it. When the computer is again available, 
you can take the task off hold. The task again runs at the scheduled time(s).

To permanently delete a scheduled task, see "Remove a Task" (p. 16).

Note: Only local tasks can be placed on hold.

Steps
1. Click the Scheduled tab in the Scheduler application window.

In the list of scheduled tasks, the word "active" in the status column indicates tasks that will 
be executed at the appointed times. The words "on hold" indicate tasks that have previously 
been put on hold; these tasks will not run at the scheduled time(s) until taken off hold.

2. Click the task you want to put on hold or take off hold.
3. From the Edit menu, click Put On Hold to put the task on hold, or click Take Off Hold to 

take the task off hold.

Related Topics
• "Edit or Reschedule a Task" (p. 15)
• "Schedule and Run Tasks" (p. 11)
• "Set Security for a Scheduled Task" (p. 13)
• "Set Task Defaults" (p. 25)
• "View Settings for a Running or Completed Task" (p. 15)

Remove a Task

Description
When a task is no longer required, you can permanently remove it from the task list.
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You can configure Scheduler to automatically remove completed tasks after a given period of time. 
For more information, see "Automatically Remove Completed Tasks" (p. 27).

To temporarily prevent a scheduled task from running, see "Put a Task On and Off Hold" (p. 16).

Note: Once you have deleted a task, you cannot recover it.

Steps
1. In the Scheduler application window, click the tab that corresponds to the list in which the 

desired task can be found.
2. Select the task.
3. From the Edit menu, click Delete Item, or press the Delete key.

If delete warnings are enabled in the Warnings tab (Options dialog box), a dialog box appears 
asking you to confirm the deletion.

4. Click OK in the confirmation dialog box to remove the task.

Related Topics
• "Refine Your Tasks" (p. 15)
• "Schedule a Task" (p. 12)

Select Multiple Tasks

Description
You can select more than one task at a time using the row selector (first) column of the Scheduled 
and Completed main windows. After you select multiple tasks, you can delete them, place them on 
hold, or take them off hold.

Steps
1. Click a task on which you want to take action.
2. Ctrl+click the row selector (first) column of the second and all subsequent tasks you want to 

select together.
3. Take the action you want on the selected tasks.

Related Topics
• "Schedule a Task" (p. 12)
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Chapter 5: Work With Completed Tasks

Scheduler automates several options for working with completed tasks.

You can have Scheduler automatically:
• Print the results of a scheduled Impromptu or PowerPlay report on a specified printer.
• Save the results of an Impromptu or PowerPlay report in a specified location and file format.
• Save a Snapshot of an Impromptu report in a specified location.
• Save an Impromptu or PowerPlay Report in HTML, and save the resulting HTML files in a 

specified location.
• Launch an application or macro upon completion of an Impromptu or PowerPlay report.

Note: If selected, any of the above processes is executed automatically upon completion of a 
locally scheduled task.

From Scheduler, you can manually send the results of a completed task as an attachment to an 
email message.

Related Topics
• "Launch Applications and Macros Upon Completion of a Report" (p. 21)
• "Run PowerPlay Transformer in Batch Mode Using Scheduler" (p. 39)
• "Run PowerPlay Transformer in Batch Mode Using Scheduler" (p. 39)
• "Print the Results of a Scheduled Impromptu or PowerPlay Report" (p. 20)
• "Publish Impromptu and PowerPlay Reports in HTML" (p. 22)
• "Save a Snapshot for a Scheduled Impromptu Report" (p. 20)
• "Save the Results of an Impromptu or PowerPlay Report" (p. 21)
• "Send Results By Email" (p. 19)
• "Schedule a Task" (p. 12)

Send Results By Email

Description
You can send the results of a completed report as an attachment to an email message.

Notes
• The Send command is available only when the selected task produces an output file (for 

example, a snapshot).
• You need to install an email application before you can email the results of a report directly 

from Scheduler.
• Scheduler is set up for email applications that use the MAPI protocol. If you use a non-MAPI 

email application, your administrator must customize Scheduler.

Steps
1. From Completed tasks list, click on the task for which you want to send results.
2. From the File menu, click Send.

If you are sharing results, a dialog appears containing the name of the last file sent by 
Scheduler. If you are not sharing results, all files created by the report appears as attachments 
to a new Microsoft Mail or Microsoft Exchange message.

3. Do one of the following:
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• If the file name that appears contains the results you want to send, click OK.
• If the file name that appears does not contain the results you want to send, type the 

correct file name and click OK.

Print the Results of a Scheduled Impromptu or PowerPlay Report

Description
You can schedule the results of a report to print automatically when the report finishes running.

Notes
• The print option is available only if you have access to a printer.

Steps
1. Schedule an Impromptu or PowerPlay report. For more information, see "Schedule a 

Task" (p. 12).
2. From the Insert Task dialog box, click the Results tab.

The Results tab only appears if the file name you have typed in the File Name box of the 
Insert Task dialog box ends in the .imr (Impromptu report), or .PPR (PowerPlay report) file 
extension.

3. Select the Print check box.
More print options appear.

4. Select a printer from the drop down list.
5. Select the number of copies to print.
6. Click OK.

Save a Snapshot for a Scheduled Impromptu Report

Description
You can schedule an Impromptu report to be saved as a snapshot. A snapshot is a permanent local 
copy of the data in your report. Like a photograph, it shows the data at the moment you created 
the snapshot. 

Example
You create and save a snapshot of this month’s sales report to compare it in the future to any 
subsequent month’s sales report.

Note
• When you refresh a snapshot, by scheduling the report to be saved as a snapshot again, all 

data in the snapshot is overwritten with the current data, unless you specify a different file 
name for the updated snapshot.

Steps
1. Schedule an Impromptu Report. For more information, see "Schedule a Task" (p. 12).
2. From the Insert Task dialog box, click the Results tab.

The Results tab only appears if the file name you have typed in the File Name box of the 
Insert Task dialog box ends in the .imr (Impromptu report), or .PPR (PowerPlay report) file 
extension.

3. Select the Save Snapshot with Report check box.
More snapshot options appear.

4. In the Snapshot File Name box, enter the location and file name to save the snapshot under, or 
click Browse to show the File Name box, where you can search for the file name and location 
you want.

5. Click OK.
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Related Topics
• "Save the Results of an Impromptu or PowerPlay Report" (p. 21)
• "Work Smart" (p. 37)
• "Work With Completed Tasks" (p. 19)

Save the Results of an Impromptu or PowerPlay Report

Description
You can schedule the results of a report to be exported to a local file of the specified format.

Example
You created an Impromptu report and want to send it to a customer who only has Microsoft 
Excel. You export the report in Excel format.

Steps
1. Schedule an Impromptu or PowerPlay Report. For more information, see "Schedule a 

Task" (p. 12).
2. From the Insert Task dialog box, click the Results tab.
3. Select the Save As check box.

More save options appear.
4. From the Save As Type list, select the data type for your saved results.
5. In the File Name box, enter the location and file name to save the results under, or click 

Browse to show the File Name box, where you can search for the file name and location you 
want.

6. Click OK.

Related Topics
• "Launch Applications and Macros Upon Completion of a Report" (p. 21)
• "Save a Snapshot for a Scheduled Impromptu Report" (p. 20)
• "Work Smart" (p. 37)
• "Work With Completed Tasks" (p. 19)

Launch Applications and Macros Upon Completion of a Report

Description
You can schedule an Impromptu or PowerPlay report so that Scheduler launches an application, a 
file, or a macro when the report finishes running.

Notes
• Scheduler will only open files that are associated with an application.

Steps
1. Schedule an Impromptu or PowerPlay Report. For more information, see "Schedule a 

Task" (p. 12).
2. From the Insert Task dialog box, click the Results tab.

The Results tab only appears if the file name you have typed in the File Name box of the 
Insert Task dialog box ends in the .imr (Impromptu report), or .PPR (PowerPlay report) file 
extension.

3. Select the Command script check box.
More command script options appear.

4. In the Script file name box, enter the full location and file name of the application, file, or 
macro you want Scheduler to execute, or click Browse to show the File Name box, where you 
can search for the file name and path location you want.
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5. Click OK.

Related Topics
• "Work With Completed Tasks" (p. 19)

Publish Impromptu and PowerPlay Reports in HTML

Description
You can schedule Impromptu and PowerPlay reports to be saved in HyperText Markup Language 
(HTML) file format. An HTML report is a read-only report that you can view with a Web 
browser. You do not need Impromptu or PowerPlay on your desktop to view it. To the user, an 
HTML report looks similar to the Impromptu or PowerPlay report. 

When you save a report in HTML, Impromptu and PowerPlay create several files of different 
types. The quantity and types of files created depend upon
• the size of the report
• the number of graphics
• the inclusion of a Report Navigator 
• the navigation options you’ve specified

When you distribute the HTML report, include all of its files.

You can distribute HTML reports by
• making them available worldwide on an internet Web page
• making them available within your organization on your intranet Web page
• sending them to specific users via email
• making them available on a network

Notes
• The Save As HTML command for Impromptu reports requires a printer to correctly format 

the report.
• For further information about saving reports in HTML format, see the online help for 

PowerPlay or Impromptu.

Steps
1. Schedule an Impromptu or PowerPlay Report. For more information, see "Schedule a 

Task" (p. 12).
2. From the Insert Task dialog box, click the Publish tab.

The Publish tab only appears if the file name you have typed in the File Name box of the 
Insert Task dialog box ends in the .imr (Impromptu report), or .PPR (PowerPlay report) file 
extension.

3. Select the To HTML check box.
More options appear. The options that appear differ depending on whether you are 
scheduling a PowerPlay or Impromptu report (see notes below).

4. Enter the directory path of the folder the resulting HTML files are to be saved in.
5. For Impromptu reports only, in the Prefix box, type a meaningful name that you want as the 

prefix on all of the HTML files created for the report.
6. For Impromptu reports only, 

To Click 

Include a Report Navigator Include Report Index

Show the Report Navigator on a separate page from the report 
body

On separate page
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7. Click OK. 
Scheduler creates all the HTML files for the report in the specified location.

8. To verify the HTML report, double-click the file with the prefix you specified and the 
extension .HTM.
The Web browser displays the report. Verify that the format of the report appears as expected 
and that it contains the navigation options you want.

Related Topics
• "Work With Completed Tasks" (p. 19)

Include a list of page numbers, corresponding to the pages in the 
report body, enabling the user to jump to a specific page

Include Page Numbers

To Click 
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Chapter 6: Customize Scheduler

You can change several configuration settings in Scheduler. You can set
• Scheduler to show warning messages before deleting a task or exiting the application before 

scheduled local tasks have run.
• default locations and times for new tasks.
• Scheduler to notify you of completed tasks with a dialog box, an audible alarm, or both.
• the maximum delay allowed before the start of a task.
• Scheduler to automatically remove completed and canceled tasks from the task lists after a 

specified number of days.
• Scheduler to run minimized in the recessed tray at the end of the Windows taskbar (this tray 

may also contain the clock and other icons). This is useful for starting scheduled tasks, 
without keeping a Scheduler window open.

You can also control the appearance of the tasks lists. For more information, see "Customize the 
Scheduled and Completed Task Lists" (p. 33).

Related Topics
• "Run Scheduler in the Taskbar Tray" (p. 27)
• "Set Task Defaults" (p. 25)
• "Set the Maximum Delay Before Starting a Task" (p. 26)
• "Show Warning Messages" (p. 25)

Show Warning Messages

Description
Scheduler can show confirmation messages before you delete a task or exit the application when 
you have local tasks scheduled to run.

Note: By default, both of these warning options are enabled.

Steps
1. From the Tools menu, click Options.

The Warnings tab (Options dialog box) appears.
2. Select the Deleting check box to cause Scheduler to show a confirmation message before 

deleting a task.
3. Select the Exit With Active Local Schedules check box to cause Scheduler to show a 

confirmation message before exiting the application when you have scheduled tasks to run on 
your computer.

4. Click OK.

Related Topics
• "Customize Scheduler" (p. 25)

Set Task Defaults

Description
You can change the default settings that will apply to new tasks. You can set tasks to run by 
default on your local computer and set a default scheduled time for the task.
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Steps to Set the Default Time for New Tasks
1. From the Tools menu, click Options.
2. Click the New Task.
3. Select the default scheduled time for new tasks.

4. If you selected the At option button, set the desired default scheduled time (in 24-hour 
format) in the At box.
Note: When you schedule a new task based on default settings, and the time in the At box is 
earlier than the current time on your computer’s clock, the task date for the new task will 
default to the next calendar day.

5. Click OK.

Related Topics
• "Customize Scheduler" (p. 25)
• "Edit or Reschedule a Task" (p. 15)
• "Schedule a Task" (p. 12)
• "Set Security for a Scheduled Task" (p. 13)
• "View Settings for a Running or Completed Task" (p. 15)

Set the Maximum Delay Before Starting a Task

Description
If Scheduler is not running, tasks scheduled to run locally can not be started. Similarly, if the 
scheduled execution time for a task arrives while Scheduler is running another task, the task can 
not be started. These tasks are delayed until Scheduler becomes available, or until the maximum 
delay has elapsed. After the maximum delay has elapsed, Scheduler skips the task.

You can specify the maximum delay permitted before scheduled tasks are started. This ensures 
that Scheduler does not amass a large backlog of scheduled tasks.

Notes
• The default maximum delay value is 8 hours
• Valid settings for the maximum delay are 1 to 12 hours.

Steps
1. From the Tools menu, click Options.

The Options dialog box appears.
2. Click the Start tab.
3. Enter the number of hours for the maximum delay in the Task Execution No Later Than box.
4. Click OK.

Related Topics
• "Customize Scheduler" (p. 25)
• "Schedule a Task" (p. 12)

Select To 

Immediately Use the current time as the default scheduled time for new tasks.

At Use a specific time as the default scheduled time for new tasks.
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Automatically Remove Completed Tasks

Description
Completed tasks are listed on the Completed tab (Scheduler application window) task list. You 
can set Scheduler to remove tasks from this task list automatically after a given period of time.

Notes
• Auto Purge affects local tasks only.
• Auto Purge must be set for automatically deployed tasks.
• If you delete tasks containing shared results, the exported file will also be deleted along with 

the exported data.

Steps
1. From the Tools menu, click Options.
2. Click the Purge tab.
3. Select whether Scheduler should automatically remove completed tasks.

4. If you selected the Purge After option, in the Purge After box, type the number of days after 
which Scheduler automatically removes a completed task from the task list.

5. Click OK.

Related Topics
• "Remove a Task" (p. 16)
• "Customize Scheduler" (p. 25)

Run Scheduler in the Taskbar Tray

Description
You can run Scheduler minimized in the recessed tray at the end of the Windows taskbar. This tray 
may also contain the clock and other icons. Run Scheduler in the taskbar tray to start scheduled 
tasks, without keeping a Scheduler window open.

Notes
• Hold the pointer over the Scheduler icon in the taskbar tray to view a tool tip which shows 

the number of remote results sets.
• Double-click the Scheduler icon in the taskbar tray to open a Scheduler window.
• Right-click the Scheduler icon in the taskbar tray to open a pop-up menu, allowing you to 

Show or Hide the Scheduler window or Exit Scheduler.
• If the Run in Taskbar Tray option is selected when Scheduler is opened, Scheduler will open in 

the taskbar tray, rather than a window.
• When Scheduler is set to run in the taskbar tray, clicking

button closes the Scheduler window, but Scheduler remains open in the taskbar tray. To exit 
Scheduler, when Scheduler is set to run in the taskbar tray, right click the Scheduler icon in the 
taskbar tray and click exit from the pop-up menu.

Select To

Auto Purge Off Leave completed tasks on the task list indefinitely.

Purge After Cause Scheduler to automatically remove completed tasks from the 
task list after a given number of days.
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• If you minimize the Scheduler window while Scheduler is set to run in the taskbar tray, 
double-clicking the Scheduler icon in the taskbar tray does not open a Scheduler window. In 
this case, you must click the Scheduler button on the taskbar to open a Scheduler window.

Steps
1. From the Tools menu, click Options.

The Options dialog box appears.
2. Click the Mode tab.
3. Select the Run in Taskbar Tray check box.
4. Click OK.

The Scheduler window is minimized and the Scheduler icon appears in the taskbar tray.

Related Topics
• "Customize Scheduler" (p. 25)
• "Run an Unattended Task" (p. 5)

Customize Scheduler to Work with Non-MAPI Email Platforms

Description
You can customize the Send command in Scheduler to work with email platforms that use mail 
protocols other than MAPI. 

Note: If this procedure is not performed properly, the Send command will no longer work. 
Proceed with caution.

Notes
• Scheduler must be closed when a new .dll file is made: if Scheduler is open and you use the 

default name and path for the new .dll, an error will occur, or if you choose a different name 
or path for the new .dll, the new capabilities will not be available until you exit and restart 
Scheduler.

• See the documentation that comes with your email application to determine the OLE 
automation interface available with your mail protocol.

Steps
1. Close Scheduler, if necessary.
2. In an application that can make .dll files, for example Visual Basic, create a class called 

clsSend with the Instancing property set to Multiuse.
3. Copy the example script below and paste into the script window for the class.
4. Modify the script using the OLE automation interface of your mail protocol.
5. Make the .dll file.

The name of the installed .dll file is Send32.dll, but you can use any name or path. 
Note: Do not move the new .dll file. If you move it, it will prevent Scheduler from locating it 
and the Send command will no longer work.

6. Test the Send command in Scheduler.
7. Repeat steps 4 to 6 until the Send command works properly.

For an example, see "Example Code" (p. 29).

Related Topics
• "Send Results By Email" (p. 19)
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Example Code
The following examples are:
• a template to add the send capabilities for your mail protocol.
• the code for the default Send command capability, which can be compiled to return to the 

default Send command capability.

Code Template
Public Sub Send(Schedule As Object)
  'This subroutine will be called when the Send Results command
  'is used in Scheduler.
  Const IMP_TASK = 1
  Const PPLAY_TASK = 2
  Dim strFileExists As String
  Dim strFileName As String
  'Place code here to declare the objects you will require to 
  'generate a new mail message with an attachment in your mail
  'system here.
  'Place code here to activate an automation session for your 
  'mail system.
  'Place code here to log on to your mail system.
  'Place code here to create a new, blank message in your 
  'mail system.
  If Schedule.CreateSnapshot Then
    If Schedule.SnapshotFileName = "" Then
      strFileName = Schedule.ScheduleName
    Else
      strFileName = Schedule.SnapshotFileName
    End If
    strFileExists = Dir(strFileName)
    If strFileExists <> "" And Err.Number = 0 Then
  'Place code here to place the file described by strFileName 
  'into the new message as an attachment.
    End If
  End If
  If 0 <> Len(Schedule.ExportType) Then
    strFileName = Schedule.ExportFileName
    strFileExists = Dir(strFileName)
    If strFileExists <> "" And Err.Number = 0 Then
  'Place code here to place the file described by strFileName 
  'into the new message as an attachment.
    Else
      If Schedule.TaskType = PPLAY_TASK Then
        If Schedule.ExportType = "csv" Then
          strFileName = Trim(strFileName) + ".asc"
        Else
          strFileName = Trim(strFileName) + ".xls"
        End If
        strFileExists = Dir(strFileName)
        If strFileExists <> "" And Err.Number = 0 Then
  'Place code here to place the file described by strFileName 
  'into the new message as an attachment.
        End If
      End If
    End If
  End If
  'Place code here to update and send the new message.
  'Place code here to close the automation session for your 
  'mail system.
End Sub

Default Send Command Code
Public Sub Send(Schedule As Object)
    'Enable a user to send the physical files created by a request 
    'to others via a MAPI session
    Const IMP_TASK = 1
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    Const PPLAY_TASK = 2
    Dim MapiSession As Object
    Dim MapiMessage As Object
    Dim MapiRecipient As Object
    Dim MapiAttachment As Object
    Dim Recpt
    Dim errObj As Long
    Dim ErrMsg
    Dim FileExists As String
    Dim FileName2 As String
    Const mapiFileData = 1
    Const mapiHigh = 1
    Const mapiTo = 1
    Const MAPI_USER_CANCEL = &H80040113
    On Error GoTo MAPITrap
    Set MapiSession = CreateObject("Mapi.Session")
    MapiSession.Logon
    Set MapiMessage = MapiSession.Outbox.Messages.Add
    With MapiMessage
        If Schedule.CreateSnapshot Then
            If Schedule.SnapshotFileName = "" Then
                FileName2 = Schedule.ScheduleName
            Else
                FileName2 = Schedule.SnapshotFileName
            End If
            FileExists = Dir(FileName2)
            If FileExists <> "" And Err.Number = 0 Then
                Set MapiAttachment = MapiMessage.Attachments.Add
                With MapiAttachment
                    .Name = FileName2
                    .Source = .Name
                    .ReadFromFile filename:=.Name
                    .position = 1
                    .Type = mapiFileData
                End With
            End If
        End If
        If 0 <> Len(Schedule.ExportType) Then
            FileName2 = Schedule.ExportFileName
            FileExists = Dir(FileName2)
            If FileExists <> "" And Err.Number = 0 Then
                Set MapiAttachment = MapiMessage.Attachments.Add
                With MapiAttachment
                    .Name = FileName2
                    .Source = FileName2
                    .ReadFromFile filename:=FileName2
                    .position = 1
                    .Type = mapiFileData
                End With
            Else
                If Schedule.TaskType = PPLAY_TASK Then
                    If Schedule.ExportType = "csv" Then
                        FileName2 = Trim(FileName2) + ".asc"
                    Else
                        FileName2 = Trim(FileName2) + ".xls"
                    End If
                    FileExists = Dir(FileName2)
                    If FileExists <> "" And Err.Number = 0 Then
                        Set MapiAttachment = MapiMessage.Attachments.Add
                        With MapiAttachment
                            .Name = FileName2
                            .Source = FileName2
                            .ReadFromFile filename:=FileName2
                            .position = 1
                            .Type = mapiFileData
                        End With
                    End If
                End If
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            End If
        End If
        .Update
        .Send showdialog:=True
    End With
    Set MapiSession = Nothing
MAPIExit:
    Exit Sub
MAPITrap:
    If Err.Number <> MAPI_USER_CANCEL Then
        Err.Raise Number:=Err.Number, Description:=Err.Description
    Else
        If Not MapiMessage Is Nothing Then
            MapiSession.Outbox.Messages.Delete
        End If
    End If
End Sub
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Chapter 7: Customize the Scheduled and 
Completed Task Lists

Scheduler maintains two separate lists showing Scheduled and Completed tasks. They are 
contained in the Scheduled and Completed tabs of the Scheduler application window.

Each list appears in the form of a table. You can move, size, or hide the columns in these two 
tables. You can control the background color and font for each of the two lists. Each tasks list has 
its own settings, independent of the other.

Changes to the tasks lists are saved in the Cern.ini file, when you exit the application.

Related Topics
• "Customize Background Color and Font" (p. 35)
• "Customize Scheduler" (p. 25)
• "Hide and Show Columns" (p. 33)
• "Size and Move Columns" (p. 34)
• "Sort Tasks" (p. 33)

Sort Tasks

Description
You can sort tasks in the Scheduled or Completed tasks lists by any of the columns.

Tip
To sort without using menus, click within the heading of the column you want to sort on. A 
second click will reverse the sort order.

Steps
1. Open Scheduler to the tasks list that you want to sort.
2. From the View menu, place the cursor over the Sort On command and select the column to 

sort on.

Related Topics
• "Customize the Scheduled and Completed Task Lists" (p. 33)

Hide and Show Columns

Description
You can hide or show any of the columns in the Scheduled and Completed tasks lists.

Steps to Hide Columns
1. From the Scheduled or Completed tasks list, click and hold the on the right border in the 

header of the column you want to hide.
When the pointer moves over a column border, it changes.

2. Drag the border to the left until it meets the border of the adjacent column and the column is 
completely hidden.

3. Release the mouse button.
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Steps to Show Hidden Columns
1. In the Scheduled or Completed tasks list, slowly move your pointer across the column 

headers.
When the pointer moves over a column border where another column is hidden, the pointer 
icon will change.

2.  Click and hold on the border where the column is hidden.
3. Drag the border to the right until the hidden column is revealed.
4. Release the mouse button.

Step to Show All Hidden Columns
• From the View menu, click Show Hidden Columns.

All hidden columns in the current task list are restored to their default size. The size and 
position of other columns are unaffected.

Related Topics
• "Customize the Scheduled and Completed Task Lists" (p. 33)
• "Size and Move Columns" (p. 34)

Size and Move Columns

Description
You can move or resize the columns in the Scheduled and Completed tasks lists to suit the way 
you work. You may want to 
• shrink columns, so that they all fit within your display and can be viewed without scrolling.
• enlarge columns, to view all the text they contain.
• move columns into an order you prefer.

Notes
• When a column is smaller than the width of the header text, the header text scrolls to the next 

line, if there is vertical room in the header.

Tip
To deselect columns, click anywhere outside of the selected columns' headers.

Steps to Shrink and Enlarge Columns
1. From the Scheduled or Completed tasks list, left-click and hold on the right border in the 

header of the column you want to resize.
2. Drag the border to the left to shrink the column, or to the right to enlarge the column.
3. Release the mouse button.

Steps to Move Columns
1. Left-click and hold the left mouse button within the header of the column you want to move.
2. Drag the pointer to the top or bottom of the header cell to select a single column, or drag the 

pointer into the header cells to the left or right to select a range of columns.
3. Release the mouse button.

The selected columns remain shaded.
4. Click and hold again within the header of the selected column, or columns.

The divider at the left border of the selected column(s) is enlarged and highlighted
5. With the mouse button depressed, drag the highlighted border to the desired location.
6. Release the mouse button.

The selected column(s) are moved immediately to the left of the highlighted border. Columns 
remain selected after they are moved.
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Related Topics
• "Customize the Scheduled and Completed Task Lists" (p. 33)
• "Hide and Show Columns" (p. 33)

Customize Background Color and Font

Description
You can customize the background color and font of the Scheduled and Completed tasks lists.

Steps to Customize the Background Color
1. Open Scheduler to the desired task list.
2. From the Tools menu, select Background.

The Color dialog box appears.
3. Select a color.
4. Click OK.

Steps to Customize the Font
1. Open Scheduler to the desired task list.
2. From the Tools menu, select Font.

The Font dialog box appears.
3. Select a font.
4. Click OK.

Related Topics
• "Customize the Scheduled and Completed Task Lists" (p. 33)
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Chapter 8: Work Smart

You can use Scheduler to maximize your efficiency by learning how to work smart. This section 
provides sample tasks that can show you how to work smart by
• scheduling an Open Impromptu report directly from Impromptu
• opening an Impromptu report for Scheduling
• running a CognosScript macro using Scheduler
• running PowerPlay Transformer in batch mode using Scheduler

Related Topics
• "Open an Impromptu Report for Scheduling" (p. 37)
• "Launch Applications and Macros Upon Completion of a Report" (p. 21)
• "Run a CognosScript Macro Using Scheduler" (p. 38)
• "Run PowerPlay Transformer in Batch Mode Using Scheduler" (p. 39)
• "Update the Database User Profile for an Impromptu Report" (p. 40)

Open an Impromptu Report for Scheduling

Description
When you open an Impromptu report, you can easily access Scheduler to schedule the report.

Impromptu supplies information about the report, including run-time prompts and security 
information. Using the Results tab (Insert Task dialog box), the results can automatically
• be printed 
• be published as HTML
• be exported 
• be saved as a snapshot
• run a macro or application

If selected, any of the above processes is executed automatically upon completion of a locally 
scheduled task.

The following procedure demonstrates how to open an Impromptu report and schedule it to run 
weekly on your local computer.

Steps
1. In Impromptu, from the File menu, click Open.

The Open dialog box is displayed.
2. Select the file name of a report to open.
3. Select the Open Scheduler check box.
4. Click OK.

Impromptu launches Scheduler to schedule the chosen report. The Insert Task dialog box is 
displayed, and the file name of the current report is automatically entered in the File Name 
box.

5. Type a description to identify the task in the Description box.
6. Select My Computer to run the task on your local computer.
7. Select Recurring Task to schedule the report to run repeatedly at selected intervals.
8. Click Timetable to show the Timetable tab (Insert Task dialog box). 
9. Select Weekly to run the task every week on selected days.
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10. Select the day(s) of the week that the task should run.
11. Set the time at which you want the task to run in the Time box.

The Effective From box shows the current date by default. The task will run every day at the 
same time starting today.
The Next Run At box shows the next date and time that the recurring task will run.

12. Click OK to save the task description.
The Insert dialog box closes and the task description appears in the task list in the Scheduled 
tab (Scheduler application window).
Because the task is scheduled to run on your computer, you must leave your computer 
switched on with the Scheduler application running.

Related Topics
• "Schedule a Task" (p. 12)
• "Work Smart" (p. 37)

Run a CognosScript Macro Using Scheduler

Description
You can schedule the execution of a CognosScript macro that runs any OLE-compliant 
application with defined methods and properties. For example, you can run a macro that updates 
your local copy of a distributed Impromptu catalog at the end of every week. Because the macro 
will run on your computer, you must leave your computer switched on with Scheduler running in 
order for the task to execute.

The following procedure describes how to schedule a CognosScript macro to run at a specified 
time every day.

Steps
1. Open the Scheduler application window.
2. From the Insert menu, click Recurring Task.
3. In the File Name box, either type the file name and path of the new task, or click Browse to 

locate the task. 
For example, you could type:
updcatlg.mac

4. Type Update Local Catalog to identify the task in the Description box.
5. Click the Timetable tab. 
6. Select Daily to run the task every day at the same time.
7. In the Time box, set the time at which you want the task to run.

The Effective From box shows the current date by default. The task will run every day at the 
same time starting today.

8. If the catalog or the database prompt for user IDs and passwords:
• Click Security to show the Security tab (Insert Task dialog box). 
• Type a user class for the task in the User Class box.
• Type the password for the user class in the first User Password box.
• If the database supports multiple user IDs, type the database user ID for the task in the 

User box.
• If the database supports multiple user IDs, type the password associated with the user ID 

in the second User Password box.
9. Click OK to save the task description.

The Insert dialog box closes and the task description appears in the task list in the Scheduled 
tab (Scheduler application window). 

10. Do not close Scheduler. To tidy your desktop, you can click the Minimize button on the top 
right of the Scheduler application window.
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Scheduler runs minimized, and the CognosScript macro will run at the scheduled time on your 
computer.

Related Topics
• "Launch Applications and Macros Upon Completion of a Report" (p. 21)
• "Work Smart" (p. 37)

Run PowerPlay Transformer in Batch Mode Using Scheduler

Description
You can schedule PowerPlay Transformer to run in Batch mode at a specific time. For example, 
you can schedule Transformer to refresh an existing PowerCube at a specific time each day.

Before Scheduling PowerPlay Transformer to run in batch mode, the PowerPlay administrator 
should set up Auto-access to the required data sources. This ensures that authenticator attempts to 
identify the user via their OS signon, thereby eliminating the need for user interaction.

The following procedure describes how to schedule PowerPlay Transformer to run in batch mode. 
Because the macro will run on your computer, you must leave your computer switched on with 
Scheduler running in order for the task to execute.

Steps
1. Open the Scheduler application window. 
2. From the Insert menu, click Task. 
3. In the File Name box, type trnsfrmr.exe, the file name of the PowerPlay Transformer 

executable file. Add the path, if necessary. 
You can also click Browse to open the File Name dialog box, where you can locate the file. 
Type the appropriate batch mode switches, and then type the name of the model file.
For example, you could type:
"trnsfrmr.exe" -n -s "national.pyi"

4. Type Transformer Batch Mode in the Description text box to identify the task.
5. Click Timetable to show the Timetable tab (Insert Task dialog box). 
6. Select the time at which you want the task to run in the Time box.
7. Set the date for the task to be run in the On box.

You must select tomorrow's date for the task to run overnight, as the time has been set after 
midnight. For example, click the arrow keys to change the date to 22/03/04 (March 22, 
2004).

8. If the catalog or the database prompt for user IDs and passwords:
• Click Security to show the Security tab (Insert Task dialog box). 
• Type a user class for the task in the User Class box.
• Type the password for the user class in the first User Password box.
• If the database supports multiple user IDs, type the database user IDs for the task in the 

User ID box.
• If the database supports multiple user IDs, type the passwords associated with the user 

IDs in the second User Password box.
9. Click OK.

The Insert Task dialog box closes, and the task description appears in the task list in the 
Scheduled tab (Scheduler application window).

10. Do not close Scheduler. You can click the Minimize button on the top right of the Scheduler 
application window.
Scheduler runs minimized, and Transformer will run at the scheduled time on your computer.

Related Topics
• "Launch Applications and Macros Upon Completion of a Report" (p. 21)
• "Work Smart" (p. 37)
User Guide  39



Chapter 8: Work Smart 
 

Update the Database User Profile for an Impromptu Report

Description
You can update the database user logon and password for any active scheduled Impromptu report 
to match changes in the database.

Notes
• This command is always available when you select multiple tasks.

Steps
1. Select the task with the database user profile you want to update.
2. From the Edit menu, click Updating Database Profile.
3. Enter the new user ID in the User ID box.
4. Enter the new user password associated with the user ID in the User Password box and click 

OK.
Note: Each password character you enter appears as an asterisk (*) for security purposes.

Related Topics
• "Schedule a Task" (p. 12)
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Description
Once Scheduler runs a task, the task appears on the task list in the Completed tab (Scheduler 
application window). If the task generated an error, a description of the error appears in the 
Errors column on this list.

Whenever a serious error is raised, Scheduler creates the file schederr.log in the directory used by 
Windows for temporary files. In the error log, Scheduler records the module that was executing 
and error information. Use a text editor to open and review the errors recorded in this file.

Below are some tips for troubleshooting errors generated by tasks on your local computer.

For help on specific Impromptu error messages, see "Troubleshoot Impromptu Errors" (p. 41).

Local Tasks
• Scheduler could not start the application required to run the task. Check that the correct path 

and file name for the application was specified in the File Name box on the Identification tab 
(Insert Task dialog box). If other applications or tasks were running, it could be that your 
computer did not have enough memory to start the application.

• Scheduler could not find the Impromptu report definition (.imr file). Check if this file was 
renamed or deleted.

• The catalog could not be opened. Check that the correct user class and password are specified 
in the macro or in Scheduler.

• The database could not be opened. Check that the correct user IDs and passwords were 
specified in the macro or in Scheduler. The database might no longer exist, or perhaps the 
database was not accessible when the task was run.

• If a scheduled Impromptu report does not have current security information for a catalog or 
database, delete the task and schedule a new one to ensure that current information is being 
used.

• There may have been errors during the query, or errors in OLE (Object Linking and 
Embedding) methods. Consult the Impromptu documentation for more information.

• The options set for the report caused an error. When Impromptu runs a report, it keeps track 
of execution errors in a log file. You can review this file if you encounter problems launching 
Impromptu reports from Scheduler. For more information, see "Troubleshoot Impromptu 
Errors" (p. 41).

Related Topic
• "Processing Considerations for Local Tasks" (p. 6)

Troubleshoot Impromptu Errors

Description
Once Scheduler runs a task, the task appears on the task list in the Completed tab (Scheduler 
application window). If the task generated an error, a description of the error appears in the 
Errors column on this list.

As well, when Impromptu runs a report, it logs execution errors in the Imprmptu.log file in the 
directory where Impromptu was installed. Use a text editor to open and review errors.

The following errors may be generated by Impromptu when working with Scheduler:
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Impromptu has no active reports at this moment.
Scheduler has requested information about the report currently open in Impromptu, but 
Impromptu does not have any reports open.

The active report has not been saved yet.
Scheduler is adding the report currently open in Impromptu to the schedule, but the report has not 
yet been saved.

Impromptu does not have enough memory to complete the command.
Your system is low on memory. Exit open applications to free memory. You may need to restart 
Windows.

Impromptu could not open the report.
The Impromptu report (.imr) file could not be found. This file may have been renamed or deleted.

The report is not a valid Impromptu report.
The scheduled task is not an Impromptu report. The file scheduled as a report was not created by 
Impromptu, or the report file is corrupt.

Impromptu was unable to read from the report.
The scheduled task is not an Impromptu report. The file scheduled as a report was not created by 
Impromptu, or the report file is corrupt.

Impromptu cannot open the required catalog.
Impromptu was not able to open the catalog required for the report. The catalog user name and 
password may have changed, or the catalog may have been renamed or deleted.

Impromptu could not connect to the database.
Impromptu was not able to open the database required for the report. The database user name 
and password may have changed.

The report has changed since it was scheduled.
When you schedule an Impromptu report, Impromptu provides Scheduler with prompt values and 
security information. Impromptu has determined that changes affecting the SQL have been made 
since the report was scheduled. Different prompt values or security information is now required. 
Delete the task and reschedule the report to automatically obtain the updated information.

Internal read error occurred while retrieving batching information.
Impromptu could not retrieve information about the report. The most likely cause is low disk 
space.

Internal error occurred while opening a temporary file.
Impromptu could not open a temporary file. The most likely cause is low disk space or no 
permission to create files in a specific directory.

Internal error occurred while storing batching information.
Impromptu could not save information about the report. The most likely cause is low disk space.

Internal error occurred while creating a temporary file.
Impromptu could not create a temporary file. The most likely cause is low disk space.

Related Topics
• "Troubleshoot Task Errors" (p. 41)
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Specifies preferences for Cognos applications. This file is created or updated when you install 
Impromptu, PowerPlay, or any other Cognos product that runs under Microsoft Windows.

Scheduler supports the following entries in Cern.ini:

[Cognos Locations] section
Specifies the locations of Cognos applications and components.

Scheduler Workspace=<directory>
Specifies the directory in which the local Scheduler database of scheduled and completed tasks is 
stored. If not specified, Scheduler creates the task database in the current directory and creates a 
Scheduler Workspace entry that records the directory that was used.

[Scheduler] section
Specifies settings used by Scheduler.

ClientId=<value>
Specifies a unique identifier that Scheduler provides to the server database. The ClientId is 
typically not required, as Scheduler uses your primary network login ID for this purpose. ClientId 
is required only when Scheduler cannot detect your primary network login name. 

ClientId is restricted to 31 characters or less and can be set to any unique value, such as your 
name or phone number.

Collect=<Boolean>
Specifies True or False, whether Scheduler automatically deploys results. If set to True, Scheduler 
automatically deploys results once the task is complete. If set to False, you must view the 
completed task using the View Results command or double-click the task in the Complete tab to 
deploy the results.

ExportBDO=<Boolean>
Specifies True or False, whether Scheduler shares results. If set to True, Scheduler shares results 
with other users through the user class you specified to run the report. If set to False, Scheduler 
does not share results.

OleRequestTimeOut=<milliseconds>
Specifies the number of milliseconds that Scheduler waits for Impromptu to respond to a pending 
task request when idle. If Impromptu does not respond in the specified amount of time, Scheduler 
shows a dialog box to notify you that it is waiting.

Default: 30 seconds (30,000 milliseconds)

OleBusyTimeOut=<milliseconds>
Specifies the number of milliseconds that Scheduler waits for Impromptu to respond to a pending 
task request when busy. If Impromptu does not respond in the specified amount of time, Scheduler 
shows a dialog box to notify you that it is waiting. 

Default: 30 seconds (30,000 milliseconds)
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Glossary

active
Describes the status of a task that is not on hold, and will run at its scheduled time(s). The status 
of a scheduled task is shown in the Status column on the Scheduled tab (Scheduler application 
window).

application
A computer program.

Batch mode
Batch mode is a means of executing a program (such as Transformer), and activating its 
commands to perform a specific function without user interaction.

batching database
A database connected to by the server that contains the definitions of queries to be executed on 
the server.

catalog
A file that contains all the information necessary to access and retrieve information from a 
relational database. The catalog does not store data, but it describes how to retrieve the data. A 
catalog contains information about what database to access, where the database is stored, and 
how the tables in the catalog are joined.

CognosScript
A BASIC-like language that you can use to write macros.

completed task
A task that has been successfully run. Completed tasks are listed on the Completed tab (Scheduler 
application window).

database
A collection of data related to a particular purpose and organized for ease of reference. Depending 
on the type of database you are using, a database may contain tables, views, synonyms, and stored 
procedures.

error
A problem that has prevented an operation from completing successfully.

export
Save information (such as the results of an Impromptu report) in a new file that has a different 
format.

local
Describes a task that will execute on your computer.

log
A file that records events.
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macro
A customized sequence of programmed instructions (macro commands) that a specific application 
performs.

OLE (Object Linking and Embedding)
A Microsoft Windows facility that enables applications to share data. When you use OLE, two 
applications share data through a connection that you establish.

on hold
Describes the status of a task that has been temporarily prevented from running at its scheduled 
time(s). The status of a scheduled task is shown in the Status column on the Scheduled tab 
(Scheduler application window). See also Active.

password
A code word that must be supplied with a user class or user ID to gain access to a secured 
database or catalog.

pending
The state of a task that has not yet run.

recurring task
A task that will run more than once at specified intervals.

remote
Describes a computer (such as a server) that you are connected to across a network. (Does not 
necessarily describe the location of the computer.)

rendition
An interpretation of a generation of products or a version of a product, such as language 
translations of Impromptu.

report
A view of current data in your company database that is organized and formatted the way you 
want it. Data you see in your report depends on a data you can access from your catalog. A report 
can be based on a template. A report contains frames.

scheduled task
A task that has not yet been run. Scheduled tasks are listed on the Scheduled tab (Scheduler 
application window).

snapshot
A permanent local copy of data retrieved by an Impromptu report stored on your local computer. 
Data can be shown and even manipulated at a later date without having to connect to the original 
database.

status
The state of a task that determines whether it will run at its scheduled time(s). An active task will 
run; a task on hold will not.

task
A scheduled action to be started by Scheduler. An application such as Impromptu, PowerPlay 
Transformer, PowerPlay Explorer, Portfolio, or a CognosScript macro, or a report, or an 
executable file can perform a scheduled action.
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task list
A table that lists completed, or scheduled tasks. The list can be sorted, and the table’s columns can 
be moved and sized.

unattended
A task that is started and run without user interaction. You do not have to be at your computer.

user class
A group of users (or a single user) who need access to the same data in a catalog, and who have 
the same access privileges.

user ID
The name assigned to a user that must be supplied (with a password) to gain access to a secured 
database.

warning
A confirmation message that is shown before certain actions are attempted, according to settings 
in the Warnings tab (Options dialog box).
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multiple tasks, 17
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definition, 46
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tasks, 16
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definition, 46
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publishing in HTML, 22
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results
printing, 20
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saving to a file, 21
sending, 19

running
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Scheduler in the taskbar tray, 27
unattended tasks, 5
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sample tasks, 37, 38, 39
saving
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the results of reports, 21

schederr.log, 41
scheduled task

definition, 46
Scheduler

customizing, 28
get started, 9
starting, 9
what is it, 5

scheduling
tasks, 12

security, 13
selecting, 17

multiple tasks, 17
sending results, 19
settings

defaults, 25
edit, 15

snapshot
definition, 46

snapshots
saving, 20

sorting tasks, 33
starting Scheduler, 9
status

definition, 46
suspending tasks, 16

T
taking tasks off hold, 16
task

definition, 46
task list

definition, 47
task lists

removing completed tasks, 27
taskbar tray

running scheduler in, 27
tasks

defaults, 25
deleting, 16
editing, 15
local processing considerations, 6
managing, 9
maximum delay before starting, 26
putting on hold, 16
remove completed, 27
running unattended, 5
samples, 37, 38, 39
scheduling, 12
sorting, 33
take off hold, 16
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